
 
   
File transfer setting for WinCE 
File transfer service lets you transfer pictures, documents or music files to 
other Bluetooth devices. Starting file transfer by using "Connection wizard" 
from Bluetooth manager.   
1. At "Connection wizard" , tap "Browse files on a remote device", then 
tap "Next". 

 
2. Follow the instructions on the screen to the next step. 



 
3. Then select a device, that you went to transfer the file(s) to.   

  

4. Follow the instructions to complete the connection setting, and now you can 
transfer files between the two devices.  



 
Change the Remote Device Folder 
To move down in the directory structure of the remote device, tap the new 
folder in the main portion of the Bluetooth File Explorer window. 
To move up in the directory structure of the remote device, tap the down-arrow 
to the right of the currently selected folder and select the new folder from the 
drop-down list. 
File Menu 
All of the following instructions in the subsections assume that there is an open 
File Transfer connection with a remote device. 
Send a File to the Remote Device 
To send a file to the remote device, from the File menu, tap Send a File to 
display the Open screen. 
The options on the Open screen are: 
* Folder-tap the down-arrow and select the folder that contains the file to be 
sent. 
* Type-the only option is "All Files (*. *)" 
* A list of files in the selected folder; tap the file to be sent 
* Cancel button-aborts the Send a File operation. 
The selected file is sent automatically when it is tapped, without further 
intervention, and the Bluetooth File Explorer main screen reappears. 
Create a Folder on the Remote Device 
To create a folder on the remote device, navigate to the folder in which the new 
folder will be placed, and then, from the File menu, tap Create a Folder. Enter 
a name for the new folder while the default name (New Folder) is highlighted. 



Get a File From the Remote Device 
To get a file from the remote device: 
1. Navigate to the folder on the remote device that contains the file 
2. Tap the desired file to highlight it 
3. From the File menu, tap Get. 
The file is copied to the local folder listed in the Local Folder field near the top 
of the screen. 
This operation can also be performed using the tap-and-hold technique: 
tap-and-hold the desired file and select Get from the pop-up menu. 

 
Delete a File on the Remote Device 
To delete a file on the remote device: tap the file to be deleted to highlight it, 
then, from the File menu, tap delete. Tap OK in the confirmation dialog box. 
This operation can also be performed using the tap-and-hold technique: 
tap-and-hold the desired file and select Delete from the pop-up menu. Tap OK 
in the confirmation dialog box. 



 
Dial-up networking setting for WinCE 
Dial-up Networking allows you to connect to a remote computer that is 
connected to a phone line. Once connected, you can browse the Internet, 
check your email, etc. 
The remote Bluetooth device that will provide the Dial-up Networking service 
must have access to a telephone system (either a physical or cellular 
connection). 
Devices that might provide the Dial-up Networking service include: 
* Bluetooth-enabled cellular telephones 
* Bluetooth-enabled desktop computers that are attached to a telephone 
system 
* Bluetooth modems. 
The remote computer to which you are connecting must also be attached to 
the phone system and capable of answering a call. 
1. To begin dial-up networking setup for using a cell phone, please tap 
"Partner with a cell phone" from Bluetooth connection wizard, and click 
"Next".  
NOTE: For some mobile phones, e.g. Ericsson, we recommend you use 
the "Explore a Bluetooth device" option rather than the "Partner with a 
cell phone" option when pairing. 



 
2. And prepare your cell phone in Bluetooth function enable mode, (To enable 
your cell phone's Bluetooth function, please refer to the user's guide of 
your cell phone ) and tap "Next" to continue.  

    

3. After searching, the Bluetooth manager will display the cell phones in range. 
Double-tap the cell phone icon that you wish to connect to and continue to the 
next step to pair with this cell phone.  



    

4. Please key in a passkey when prompted, and  key in the same passkey on 
the cell phone to complete the pairing process. 

 
5. Tap  "Finish" to complete this step. 



 
Create a Bluetooth Dial-up connection  
1.Create a connection to the device that will provide telephone access. 
2. From the Bluetooth Manager, My Connections tab, tap-and-hold the Dial-up 
Networking connection shortcut, and then select Connect from the pop-up 
menu. 
3. On the first Bluetooth: New Dial-up Connection screen, double-tap New 
Connection. 

 
4. On the second Bluetooth: New Dial-up Connection screen: 
a) Enter a name for the connection 
b) If dialing outside of the default country setting, enter the country code 
c) If dialing outside of the default area code setting, enter the area code 
d) Enter the phone number to be dialed. 



5. Tap OK 
Please follow the Dial-Up connection procedures above to complete the 
Dial-Up settings. 
Refer to the PocketPC documentation for assistance. 
After the connection is active, open a web browser on the PocketPC. 
Alternatively, you could set up the connection the traditional way, if the 
above method did not work for you. 
1. Click on "Start" button on the top of the menu bar. 
2. Select "Settings", click on the "Connections" tab. 

 
3. Click on the "Connections" icon. On the top "Internet Settings", click 
"Modify". 

 



4. Click "New..." to start a new connection. 

 
5. Give the new connection a name, select "Bluetooth Dialup Modem", and set 
the baud rate at "115200". 

 
6. Click "Advanced...", change the "Parity" to "Even", "Stop Bits" to "1", and 
"Flow Control" to "None". 



 
7. Click on the "TCP/IP" tab, and make sure both "Use software compression" 
and "Use IP header compression" checkboxes are selected. 

     

8. Click on the "Name Servers" tab. Some GPRS service may require you to 
enter the DNS addresses, please check with your GPRS ISP before making 
the changes. Otherwise, leave the radio button selected at "Use 
server-assigned addresses" and click "OK". 



 
9. Click "Next", enter the phone number for your GPRS connection. Then click 
"Next". 

 
10. Leave the settings as it is in this page, and click "Finish". 



 
11. Click "OK", and in the Connections page, click on the "Dialing Locations" 
tab.  
a) Change the "Location:" to "Home". 
b) Delete the entries in "Area code:" and "Country code:". 
c) Select the "Disable call waiting;" checkbox. 
d) Enter the phone number of your GPRS service again. Then click on "Dialing 
Patterns...". 

 
12. Change all entries to "G", assuming you are making a local GPRS phone 
call. Then click "OK". 



 
13. Now you have set up a GPRS Bluetooth Connection. Click the "Connect" 
button and click "OK" without entering any user name or password, within a 
few seconds you should be connected to the Internet.  
14. Open "Internet Explorer" and start surfing the net. 
Serial port setting for WinCE 
The use of a Bluetooth wireless serial port connection is identical to the use of 
a physical cable serial port connection between two devices. 
As with a physical connection, the application that will use the connection must 
be configured to use the correct serial port. 
To determine the COM port assigned to the Bluetooth serial port: 
1. From the Today Screen, tap the Bluetooth icon to open the Bluetooth 
Control Panel. 
2. Use the scroll arrows at the bottom-right of the screen to expose the Serial 
Port tab, and then select the Serial Port tab. The Outbound COM Port is listed 
in the lower portion of the screen. Configure the application that will use the 
Bluetooth Serial Port to send data to this port. 
ActiveSync setting for WinCE 
1. To establish the ActiveSync connection on a PDA, please tap "ActiveSync 
via Bluetooth" from the Bluetooth connection wizard, and click "Next".  



 
2. Make sure your computer is capable of accessing your PDA, and determine 
which "COM" port number ( For example "COM6") is used for incoming 
Bluetooth connections (refer to ActiveSync setting for Windows section). 
You will need this information later. Tap "Next" to next step. 

 
3. Make sure your PC side's ActiveSync "Connection Settings" is using the 
right COM port, click "Next". 



 
4. Tap screen and choose a device on the list.  

 
5. Select a device you want to use. 



 
6. Follow the instructions to create a shortcut for the Bluetooth ActiveSync 
connection. 

    



  

7. After the shortcut is created, you can see your device is connected with your 
computer. You can tap "Active Connections" to check the signal strength. 

   

Hosting a Personal Area Network 
To host a personal network, go to the Bluetooth Manager, choose New > 
Connect > Join a personal network > Next. The following screen will be 
shown: 



 
Choose Host a personal network and tap Next. You will then be shown the 
following screen, which allows you to "bring in" one or more guests, if desired. 
This step is optional, since guests can join later on as long as the personal 
network is active (more details in the following section). 

 
Adding devices to a personal network. 
Joining a Personal Area Network 
BTW-CE makes it easy to join an existing personal network, hosted by another 
Bluetooth device (PocketPC, desktop, etc.) From the Bluetooth Manager, 
choose New > Connect > Join a personal network > Next, but choose Join 
a personal network this time. The Bluetooth Browser will be shown for you to 
select the device that is hosting the personal network. After selecting the host, 



choose Next. A connection will then be established between your PocketPC 
and the host over the personal network. 
At this moment, you might be prompted to enter IP network settings ; if this is 
the case, choose "Use server-assigned IP address" and tap OK. 
The following warning may also be shown to you. As instructed, change the 
name of your device and tap OK. 

 
Since the network is established via Bluetooth, the network host's service 
availability, authorization and/or authentication security settings are in effect 
and may prevent you from joining the network. 

 
PAN network settings. 
After joining the personal network, you can use any application that requires 
an underlying network connection. For instance, you can view a remote folder 
via the File Explorer by choosing Open and entering a remote, accessible 
device path. 



 
Browsing files on a remote device (via the PocketPC File Explorer) after joining a personal 

network. 

Install Bluetooth on MAC O.S. 

The system requirement for using this USB Bluetooth adapter on 
MAC O.S.: 
-Mac O.S. X 10.1.4 or greater  
-One free USB port  
-If you are using Mac O.S. X prior to v.10.2, you will need to download 
Bluetooth upgrade pack, "Technology Preview 2.1" from Apple's 
website. "Technology Preview 2.1" can be found by visiting 
http://www.apple.com/bluetooth/, type Technology Preview 2.1 in the 
search block.  
Setup instructions can be found inside the upgrade pack to enable 
Bluetooth services. 
For Mac O.S. X 10.4 

(A) Setting Up Your Computer for Bluetooth  

(1) You need to set up your computer to use Apple Bluetooth Preview Release 2.1  

(2) Insert the Bluetooth USB Adapter into an open USB port on your computer.  

(3) Double-click "Apple Bluetooth.pkg." Install the Apple Bluetooth Preview Release 2 
software, then restart your computer. 

http://www.apple.com/bluetooth/


(4) Open the Bluetooth pane of System Preferences and click the Settings tab. 

 

(5) Select "Discoverable" and "Show Bluetooth status in the menu bar". 



 

(B) Pairing Your Macintosh With a Bluetooth-Enabled Phone 

(1) Before you can connect to the Internet, you need to pair your computer with your 
Bluetooth-enabled phone. 

(2) Make sure your Bluetooth-enabled phone is on and in “discoverable” mode. See 
the documentation that came with your phone. 

(3) Choose Search For Phones from the Bluetooth status menu in the menu bar. 

 

(4) Select your phone in the "Pair with a Bluetooth Device" dialog box, then click Pair. 



 

(5) Enter a passkey. Use any combination of numbers. When prompted, enter the same 
passkey on your phone.  

 

(6) Your computer is now paired with your phone. The name of your phone is listed in 
the Bluetooth status menu in the menu bar. Apple Bluetooth software remembers the 
pairing with your phone, so you should only need to pair with your phone once. 

(7) You can now use your phone to dial your Internet service provider (ISP) and connect to 
the Internet. Follow these instructions to set up your computer and connect to the Internet.  

Note: To access the Internet, you must have an active mobile phone account capable of 
digital services and an account with an ISP (fees may apply). 

(C) Connecting to the Internet With a Bluetooth-Enabled Phone  



To set up your computer to connect to the Internet with a Bluetooth-enabled phone:  
(1) Choose your phone from the Bluetooth status menu in the menu bar. 
(2) Open the Network pane of System Preferences. Choose "bluetooth modem" from 
the Show pop-up menu. 

 

Note: Make sure the "bluetooth modem" port is turned on in the Network pane of System 
Preferences. To do this, choose Active Network Ports from the Show pop-up menu, then 
select "bluetooth modem". 

(3) Enter your ISP information in the TCP/IP and PPP tabs. 

(4) Choose the model of your phone from the Modem pop-up menu in the Modem tab. 

(D) To connect to the Internet: 

(1) Choose Open Internet Connect from the Bluetooth status menu in the menu bar. 



 

(2) Choose "bluetooth modem" from the Configuration pop-up menu then click Connect. 

 

(E) Pairing Your Macintosh With Bluetooth-Enabled Devices  

Apple Bluetooth Preview Release 2 also lets you pair with other Bluetooth-enabled 
devices like Palm Powered handheld devices and other Bluetooth-enabled computers. 
Once you have paired with the device, Bluetooth remembers its name and the type of 
services it provides. Make sure the devices you want to pair with are in discoverable 
mode. See the documentation that came with the device.  

(1) Click the Paired Devices tab in the Bluetooth pane of System Preferences. 



 

(2) Click New. Bluetooth searches for Bluetooth-enabled devices in range of your 
computer.  

(3) Select the device you want to pair with and click Pair.  

(4) Enter a passkey. Use any combination of numbers. If prompted, enter the same passkey on 
your Bluetooth-enabled device.Bluetooth remembers the name of the device. To delete the 
device from the list, select it and click Delete.  

(F) Adding Serial Ports  

Apple Bluetooth Preview Release 2 allows you to add any number of serial ports to 
your computer to enable incoming and outgoing connections with Bluetooth devices.  

To add serial ports to your computer:  

(1) Click New in the Serial Ports tab of the Bluetooth pane of System Preferences. 



 

(2) Name the port and select options for it. 

 



 

Note: If the port is an outgoing port, click Select Device and then select a device from the 
Select Bluetooth Device Service list or search for a device by clicking Search.  

(G) Exchanging Files Between Bluetooth-Enabled Devices  

You can use the Bluetooth File Exchange application to exchange files between 
Bluetooth enabled devices. The Bluetooth File Exchange application is located in the 
Bluetooth folder, in the Extras folder inside the Applications folder on your hard disk.  

Make sure the devices you want to exchange files with are discoverable.  

(1) Drag the file you want to exchange onto the Bluetooth File Exchange icon. It is located in 
the Bluetooth folder, in the Extras folder inside the Applications folder on your hard disk.  

(2) Click Search in the Send Files dialog box to find the Bluetooth-enabled devices in range.  

(3) Select the name of the device you want to send files to from the list, then click Send.  

Note: If no devices are found, make sure they are in discoverable mode. To make your 
computer discoverable, select Discoverable in the Settings tab of the Bluetooth pane of 
System Preferences.  

(4) If you are asked for a passkey, enter one and click Respond. If the device receiving the 



files is prompted for a passkey, enter the same passkey on the receiving device and click 
Respond.  

(5) If the receiving device is prompted that it is preparing to receive a file, click Accept to 
receive the files. Depending on the options selected, it may ask to open the file. Click Open to 
open the file.  

(H) Synchronizing a Bluetooth-Enabled Palm Powered Device 

With a Computer Using Palm HotSync Manager  

If you have a Bluetooth-enabled, Palm Powered device, you can synchronize data 
between the device and a Bluetooth-enabled Macintosh using Palm HotSyncR 

Manager.  

Make sure you have Palm Desktop 4.0 installed on your computer. For the latest 
version of the Palm Desktop software, go to www.palm.com/macintosh  

(AA) Setting Up Your Computer to Synchronize With the Palm Powered Device  

(1) Open HotSync Manager, located in the Palm folder in the Applications folder on your hard 
disk.  

(2) Select “bluetooth-pda-sync-port” in the Connection Settings tab.  

Note: Make sure Enabled is selected in the HotSync Controls tab.  

(AB) Setting Up Your Palm Powered Device to Synchronize With Your Computer  

The following setup procedure only needs to be done once. Depending on the device, 
the names and locations of some menus may be different. For precise instructions, 
see the documentation that came with your device.  

(1) Open HotSync on your Palm Powered device.  

(2) Choose Connection Setup from the Options menu.  

(3) Click New to create a new connection and name the connection.  

(4) Choose PC from the “Connect to” pop-up menu and choose Bluetooth from the Via 
pop-up menu.  



(5) Tap to find Bluetooth-enabled devices and choose your device from the list. Click OK.  

(6) Click OK, and then click Done.  

(AC) Synchronizing Your Handheld Device With Your Computer  

(1) Choose the Bluetooth connection from the Connections pop-up menu.  

(2) Click the HotSync icon.  

How to pair with my mobile phone? 

How to pair with Nokia 6310 
(1). To activate Bluetooth on your Nokia 6310, press "Menu", select 
"Bluetooth" and "On". 
(2). From your notebook or PDA, begin a Bluetooth device search. A mobile 
phone icon will show up in the right pane of the Bluetooth software window 
with the name of your Nokia 6310. 
(3). Double click the mobile phone icon to discover the services it provides. 
You should see COM, Dial-up networking, Fax, or more, depending on the 
model of your Nokia mobile phone. 
(4). From your Nokia 6310, select "Search for Bluetooth accessories", the 
phone starts searching for devices and accessories. 
(5). Scroll to the device you want and press "Select". 
(6). If devices have not been paired, the user is asked to enter the passcode of 
the desired device. (The Nokia Bluetooth Passcode is a 1 to 16 character-long 
numeric code of your choice) 
(7). A Passkey dialog box will pop up on your notebook or PDA, type in the 
same passkey you've entered on your mobile to complete pairing. 
(8). If pairing was successful, a "Paired with ***" message box will pop up on 
your mobile phone. You should also see a tick on the side of the mobile phone 
icon in your notebook or PDA. 
(9). You are now able to use the services of your mobile phone. 
How to pair with Nokia 8910 
(1). To activate Bluetooth on your Nokia 8910, press "Menu", select 
"Bluetooth" and "On". 
(2). From your notebook or PDA, begin a Bluetooth device search for your 
Nokia 8910. 
(3). A mobile phone icon will show up in the right pane of the Bluetooth 
software window with the name of your Nokia 8910. 



(4). Double click the mobile phone icon to discover the services it provides. 
You should see COM, Dial-up networking, Fax, or more, depending on the 
model of your Nokia mobile phone. 
(5). From your notebook or PDA, double click on the service you wish to use 
and it will trigger a dialog box "Connect with ***?" on your mobile phone. 
(where *** is the name of your notebook or PDA) 
(6). Push the "Accept" button, and enter a passcode, e.g. 55 and push the OK 
button. (The Nokia Bluetooth Passcode is a 1 to 16 character-long numeric 
code of your choice) 
(7). A Passkey dialog box will pop up on your notebook or PDA, type in the 
same passkey you've entered on your mobile. 
(8). If pairing was successful, a "Paired with ***" message box will pop up on 
your mobile phone. You should also see a tick on the side of the mobile phone 
icon in your notebook or PDA. 
(9). You are now able to use the services of your mobile phone. 
For further Bluetooth functions on your Nokia mobile phone, please refer to 
Nokia's User's Guide 
How to pair with Ericsson T39m 
(1). On your mobile phone, push the "Menu" button, scroll to "Extras", "Yes", 
"Bluetooth", "Yes", "Discoverable", "Yes" to make your Ericsson mobile 
phone detectable by other Bluetooth devices. 
(2). "Discoverable for 3 minutes" message box will pop up. 
(3). From your notebook or PDA, begin a Bluetooth device search for your 
Ericsson T39. 
(4). A mobile phone icon will show up in the right pane of the Bluetooth 
software window with the name of your Ericsson T39. 
(5). Double click the mobile phone to discover the services it provides. You 
should see Serial Port, Dial-up Networking, Fax, and more, depending on the 
model of your mobile phone. 
(6). From your mobile phone, scroll to "Extras", "Yes", "Bluetooth", "Yes", 
"Discover", "Yes". A list of discovered devices appears. 
(7). You can now choose the Bluetooth device you wish to connect to, then 
select "Add to paired", the mobile phone will prompt you for a "Passkey". 
Type in a passkey, e.g. 55 and push "Yes". 
(8). A Passkey dialog box will pop up on your notebook or PDA, type in the 
same passkey you've entered on your mobile. A "Pairing Succeeded" 
message box will pop up. 
(9). On your mobile phone, enter a name for your notebook or PDA, or push 
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